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Tutorial Trotec lasercutter

Deze tutorial heeft als doel je vertrouwd te maken met de Trotec 
Speedy lasercutters. Zowel de Speedy 100 als 300 werken volgens 
gelijkaardige principes. Het verschil tussen beide toestellen is het 
werkvlak en vermogen. Indien je kan, doe je de tutorial best op de 
Speedy300.

We gebruiken Adobe Illustrator om ons ontwerp via een virtuele 
printer driver naar Trotec JobControl te sturen. Je hebt dus best 
kennis van Illustrator wanneer je met de lasercutters wilt werken.

Ook de templatefiles, die je terugvindt op de website, zijn gemaakt 
in Illustrator, gebruik ze als leidraad voor het maken van je eigen 
plotter settings in Autocad of Vectorworks.

Voor Autocad werk je met een aangepaste custom page setup voor 
je plot en is buiten de focus van deze tutorial.

Let erop dat je edu-versie van Vectorworks een PDF opslaat met 
een wachtwoord, online vind je een unlock programma om het 
wachtwoord te verwijderen en de pdf terug editeerbaar te maken.

Vooraf

Symbolen

Adobe Illustrator

Autocad

Vectorworks

wacht op de labverant-
woordelijke om je werk 

na te kijken

wees extra waakzaam, 
mogelijk gevaar.

voer een opdracht uit.



01 Ontwerp voorbereiden
in vectoren.
We gebruiken Illustrator om ons ontwerp via een virtuele printer 
driver naar Trotec JobControl te sturen.
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Tutorial Trotec lasercutter

In je tekenprogramma (Illustrator, Inkscape, AutoCAD, Vector-
works,…) zorg je ervoor dat je een onderscheid maakt tussen snij-
lijnen, graveerlijnen en binnen- en buitenlijnen. Dit doe je door 
aan je lijnen een bepaalde kleur toe te kennen. Hierdoor kan je 
later (in Jobcontrol) de snijvolgorde bepalen. Vlakken graveer je in 
grijswaarden, hoe donkerder het vlak hoe sterker er zal gegraveerd 
worden. Houd er rekening mee dat dit proces erg lang kan duren. 
Zorg ervoor dat je je document opmaakt met een RGB kleurenpro-
fiel!

Tekening opmaken

Kleurencodes Trotec Speedy 300
•	 Raster Graveren: zwart #000000
•	 Lijn Graveren: rood #FF0000 
•	 Snijlijnenin volgorde: 
•	 	 blauw #0000FF
•	 	 petroleum #336699
•	 	 cyaan #00FFFF
•	 	 groen #00FF00
•	 	 magenta #FF00FF
•	 	 geel #FFFF00

(Jobcontrol kan met nog veel meer kleuren werken, maar meestal heb je genoeg aan bo-
venstaande kleurenschema. Een volledige lijst kan je vinden in de Speedy300 template op 
de website.)

Tekenoppervlakte Het maximale tekenoppervlak bedraagt 700x400mm (afmetingen 
van het stockmateriaal en ongeveer het werkbereik van de laser-
cutter). Je blijft best telkens 0,5 cm van de rand.
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Tutorial Trotec lasercutter

Vulkleur

Lijndikte

Schaal Zorg ervoor dat je document steeds in millimeters 
staat, dit voorkomt schaalproblemen bij eventuele om-
zettingen.

De lijndikte van alle lijnen moet 0 zijn. Hiervoor toets je als lijndik-
te 0,001 mm in.

Zet je vulkleur steeds uit. Hoewel de Trotec software hier geen pro-
bleem mee heeft, kan het zijn dat je in de toekomst werkt met 
andere lasercutters waar dit voor problemen kan zorgen.

Opslaan

Tekst

Dubbele lijnen Kijk je tekening steeds na op dubbele lijnen! Elke lijn die getekend 
is,  wordt gesneden; vaak over dezelfde lijn gaan is niet efficiënt én 
houdt een reëel brandgevaar in!

Zet je tekst steeds om naar outlines.

Sla je bestand op als ai of pdf.
Wanneer je dit doet, let er dan op dat je weet in welke unit en 
schaal je document werd gemaakt. Zorg ervoor dat je steeds een 
afmeting op je ontwerp hebt die je gebruikt als referentie, her-
schalingen tussen verschillende programmas zijn steeds mogelijk 
en steeds jouw verantwoordelijkheid.
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02 Ontwerp nakijken in  
Adobe Illustrator 
Zet de illustrator file klaar om door te sturen naar JobControl
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Tutorial Trotec lasercutter

Op de desktop vind je een tutorial map (TrotecTutorial) met daarin 
het bestand ruler.ai.

Open het ruler.ai bestand in Adobe Illustrator en zet dit klaar om 
door te sturen naar JobControl. Vergewis je hiervoor van volgende 
zaken:
  •	 Staat het document in rgb kleurenmodus?
•	 Is het werkvlak op de juiste grootte ingesteld?  
•	 Staan de lijnen in de juiste kleur?  
	 tekst: zwart gevuld, geen lijnkleur 
	 graveerlijnen: rood 
	 binnenste snijlijn: blauw 
	 contour: groen
•	 Staan de lijndiktes goed?
•	 Zijn er geen dubbele lijnen? 
•	 Positioneer je ontwerp op het werkvlak.

Op de volgende bladzijde vind je een snelcursus Adobe Illustrator 
om bovenstaande aanpassingen te kunnen doen.

Document openen

Checklist

Snelcursus Illustrator
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Tutorial Trotec lasercutter

De kleurenmodus aanpassen doe je via
file-> document colormodus -> RGB Color 

Localiseer de artboard tool.
Zorg ervoor dat bovenaan het artboard 700 x 400 mm meet.
Klik op de selectietool om de artboard modus te verlaten.

Klik op de selectie tool.
Selecteer een tekst object (zwart).
Maak de vulkleur actief door er 1x op te klikken.
ga naar Select-> Same -> FillColor om alle zwarte elementen te 
selecteren.
Dubbelklik op de vulkleur en zorg dat ze zwart is (#000000)

Doe hetzelfde voor de andere kleuren. Let erop dat je voor de 
andere elementen werkt met lijnkleuren in plaats van vulkleu-
ren, je past dus rood, blauw en groen aan naar de juiste rood 
blauw en groen waarden

Slecteerde selectie tool en selecteer een tekst object (zwart).
Ga naar Select-> Same -> StrokeColor om alle zwarte elementen te 
selecteren, deze elementen hebben géén lijnkleur.
Ga naar Select->Inverse om alle elementen te selecteren die wel 
een lijnkleur hebben.

Zet bovenaan in de menubalk de lijndikte juist.

Document Colormodus

Artboard controleren

Kleuren aanpassen

Lijndikte aanpassen
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Tutorial Trotec lasercutter

Het nulpunt van de Trotec lasercutters is linksboveaan, zet daarom 
het ontwerp links bovenaan in de hoek. Dit doe je door alles te 
selecteren en te verplaatsen met de selectie tool. Houd rekening 
met de aanbevolen marges.

Roep de verantwoordelijke zodat die met jou kan overlopen welke 
stappen je ondernam om het bestand laserklaar te maken.

Ontwerp positioneren

Laat je werk controleren 



03 Ontwerp naar JobControl
sturen via virtuele printer
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Handleiding lasercutter

Nu je ontwerp helemaal klaar is, stuur je het naar de lasercutter. Dit 
doe je via een virtuele printer driver die het dan naar JobControl 
stuurt. Wanneer je het bestand print stel je bij het printen meteen 
het juiste materiaal etc in. Hoewel je dit ook nog kan aanpassen in 
JobControl is het wenselijk om dit nu te doen.

Wanneer je met eigen materiaal werkt waarvoor er geen settings 
zijn opgenomen in de materialenbibliotheek doe je dit steeds met 
de hulp en onder supervisie van de labverantwoordelijke.

Ga naar File->Print om het dialoogvenster van de printer te openen

Bestand Printen
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Tutorial Trotec lasercutter

File -> print geeft je het bovenstaande ven-
ster.
Druk links onderaan op Setup

In het dialoogvenster dat vervolgens opent 
zorg je ervoor dat de Trotec is geselcteerd en 
drukt op Preferences

Het Printer Preferences venster opent nu 
waar je de juiste instellingen dient te selec-
teren.

Printer Vensters
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Bestand Printen

Zorg hier dat de afmetingen overeen ko-
men met het ontwerp. In regel is dit steeds  
700 x  400 mm.

Hier krijg je toegang tot de materialenbiblio-
theek. Die wordt voortdurend aangepast aan 
het stockmateriaal en dient als leidraad. Hoe-
wel ze in 90% van de gevallen de optimale 
settings bevat is het steeds belangrijk om een 
kleine test te doen alvorens je een grote job 
inlaadt.

De tutorial doen we in een reststukje mdf. 
Kies als materiaal in de groep Wood voor md-
f_3mm_optimal.
Alvorens de job door te sturen roep je de ver-
antwoordelijke



04 Trotec JobControl &
Lasercutter
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Tutorial Trotec lasercutter

Job Control

Checklist

Indien JobControl nog niet geopend is, open je JobControl via de 
snelkoppeling op de desktop. 

In dit stadium zal je volgende stappen uitvoeren op basis van de 
instructies op de volgende bladzijden: 

•	 Zet de lasercutter aan, dit doe je via de kleine schakelaar  
	 links achteraan op het toestel.
•	 Verbind JobControl met de lasercutter via de daarvoor  
	 bedoelde knop (1).
•	 Ga na of de materiaalinstellingen correct zijn (2).
•	 Ga na of de job juist geladen is.
•	 Optimaliseer je job door vectoren te ordenen.
•	 Stel de focus van de lasercutter in.

Op de volgende bladzijden wordt uitgelegd hoe.
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verbind de JobControl software 
met de lasercutter (1)

Via deze knop krijg je toegang tot de materialenbibliotheek (2)
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Tutorial Trotec lasercutter

het juiste materiaal koos 
je in een vorige stap, dit is 
slechts ter illustratie.

settings voor eigen materi-
alen zoek je samen met de 
labverantwoordelijke
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Tutorial Trotec lasercutter

je optimaliseert je ontwerp door 
rechts te klikken op de job en ver-
volgens Vector Ordering te kiezen.

In het venster dat verschijnt, vink 
je overwrite aan en  kies je quick 
ordering
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Tutorial Trotec lasercutter

Bedieningspaneel

Als de oranje LED bij de aan/uit knop brandt, dan staat de machie 
af. 
Druk 1x op de aan/uit knop om de lasercutter aan te zetten, het 
oranje lichtje dooft en de groene indicator geeft aan dat de machi-
ne ingeschakeld is.
Wanneer de machine gedurende een tijd niet gebruikt wordt zal ze 
vanzelf aflsaan.

  

Je materiaal positioneer je steeds in de linker bovenhoek op de ho-
ningraat. De honingraat is zo geconstrueerd dat die inhaakt op een 
aantal regels die in de lasercutter zijn gemonteerd. Verifiëer dat de 
honingraat juist ligt en ingehaakt is in de vaste regels.

De lasercutter gebruikt de linkerbovenhoek als referentiepunt.
  

(1) (2)
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Lasercutter focussen In de lasercutter ligt een kleine afstandsmeter die je op de laserkop 
kan haken.

De lasercutter staat gefocussed wanneer de onderkant hiervan je 
materiaal net raakt.

Om de lasercutter te foccussen doe je het volgende:  
  

Checklist •	 Zorg ervoor dat de lasercutter aan staat.
•	 Leg je materiaal correct in de lasercutter.
•	 Beweeg met het bedieingspaneel de laserkop boven je  
	 plaatmateriaal. (1)
•	 Haak de afstandmeter op de laserkop, je vindt deze terug  
	 in de lasercutter.
•	 Beweeg het laserbed met het bedieningspaneel omhoog tot  
	 wanneer het net raakt. (2)
•	 Leg het afstandmetertje terug op de correcte plaats in de  
	 lasercutter.
•	 Sluit de kap van de lasercutter.
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Ontwerp uitvoeren05
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Job Uitvoeren

Nabewerkingen

Nu je ontwerp klaar staat in JobControl en de laser gefocussed 
staat rest enkel nog het uitvoeren van de job.

Hiervoor druk je op de play knop in JobControl, de afzuiging/filter 
van de lasercutter zal aanslaan en de job wordt uitgevoerd.

Let erop dat je steeds aanwezig bent bij de lasercutter! Als de laser-
cutter aan het snijden is moet er steeds iemand supervisie houden, 
bij langdurend graveerwerk vraag je uitdrukkelijk de toestemming 
van de labverantwoordelijke indien je de lasercutter alleen wil la-
ten.

Het niet naleven van deze regel betekend onverbiddelijk het ver-
liezen van je laser competenties!

Als de opdracht afgewerkt is, wacht je enkele minuten tot de rook 
volledig weg is alvorens de lasercutter te openen.

Je haalt al je materiaal uit de lasercutter, ook het afval. Hiervoor zet 
je het laserbed enkele centimeters naar beneden en haalt de ho-
ningraat uit de lasercutter. Je kan nu makkelijk het afval en kleine 
stukjes verwijderen.

Laat de lasercutter proper achter voor de volgende!
Sluit je ontwerp in illustrator en wis het ontwerp uit JobControl. Dit 
doe je door rechts te klikken op de job en ze te deleten. 



Extra informatie en 
tips&tricks06
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Wat nu? Je hebt met het voltooien van de tutorial geleerd hoe een lasercut-
ter veilig te gebruiken. Dit wil niet zeggen dat je nu een pro bent. 
Hiervoor heb je heel wat ervaring nodig die je al doende zal op-
doen in het MMLab.

Op de website vind je extra informatie omtrent laseren, zo leer je 
er hoe breed een laserstraal is wanneer je snijdt, welke materialen 
kunnen gesneden worden en welke materialen er absoluut NIET 
kunnen verwerkt worden. Daarnaast vind je er ook een overzicht 
van de andere machines.

Lasercutters zijn namelijk niet de enige machines die je kan gebrui-
ken in je prototypes en maquettes. Snijplotters, 3d-printers en CNC 
machines behoren ook steeds tot de mogelijkheden. Elk van die 
machines heeft een eigen workflow die je zal moeten leren aan 
de hand van tutorials. Eén constante zal je echter steeds terugvin-
den, je vertrekt steeds uit een uitermate uitgepuurde vectoriëel 
bestand. 

Kennis van het ontwerpen in CAD programmas is daarom onont-
beerlijk! Je bent steeds welkom voor advies in het MMLab en hoeft 
hiervoor geen afspraak te maken. 



Trotec Speedy 300/100
Tutorial en Leidraad


